MTI RFID Explorer
User Manual
Version 1.0.0

MTI Group Proprietary Information
Any unauthorized use, duplication, reproduction, or disclosure of this document may be considered as infringement of MTI Group's intellectual property rights, the infringer may be accused and liable applicable legal penalties.
# Table of Contents

1 Introduction .......................................................................................................................... 5  
1.1 Overview .......................................................................................................................... 5  
2 Explorer Installation .............................................................................................................. 6  
  2.1 Installation Requirements .................................................................................................. 6  
  2.2 Installation ....................................................................................................................... 6  
  2.2.1 Installation Procedure .................................................................................................. 6  
  2.2.2 Removal Procedure ...................................................................................................... 6  
  2.2.3 Configuring for Serial Operation ................................................................................ 7  
3 Explorer Usage ..................................................................................................................... 8  
  3.1 Explorer Appearance ........................................................................................................ 8  
  3.2 Detect a Device and Select a Mode .................................................................................. 9  
  3.2.1 Detect a Device ........................................................................................................... 9  
  3.3 Controlling a Device ....................................................................................................... 9  
  3.3.1 Inventory Rules .......................................................................................................... 10  
  3.3.2 Tag Access ................................................................................................................ 10  
    3.3.2.1 Access Type Read .................................................................................................. 10  
    3.3.2.2 Access Type Write ............................................................................................... 11  
    3.3.2.3 Access Type Kill ................................................................................................. 12  
    3.3.2.4 Access Type Lock ............................................................................................... 12  
    3.3.2.5 Access Type BlockWrite .................................................................................... 13  
    3.3.2.6 Access Type BlockErase ................................................................................... 14  
  3.4 RFID Data Views ........................................................................................................... 15  
    3.4.1 Overview .................................................................................................................. 15  
    3.4.2 Performing Post-Capture Processing ....................................................................... 16  
  3.5 Exporting Data ............................................................................................................... 18  
  3.6 Logging Data .................................................................................................................. 19  
  3.7 Accessing and Changing Reader Configuration ............................................................ 21  
    3.7.1 Settings Page ............................................................................................................ 22  
    3.7.2 Antenna Configuration Page ..................................................................................... 22  
    3.7.3 Select Criteria Page .................................................................................................. 24  
    3.7.4 Inventory Algorithm Panel ....................................................................................... 25  
    3.7.5 Post Singulation Criteria Page .................................................................................. 26  
    3.7.6 GPIO Pin Configuration Page ................................................................................... 28  
    3.7.7 About Reader Page .................................................................................................. 29
3.7.8 Troubleshooting Panel.................................................................................................................. 29
3.7.9 Register Access Panel.................................................................................................................. 30
    3.7.9.1 Register Type Mac ............................................................................................................... 30
    3.7.9.2 Register Type MacBank ..................................................................................................... 31
    3.7.9.3 Register Type Bypass ......................................................................................................... 32
    3.7.9.4 Register Type OEM ............................................................................................................ 33
3.8 RF Test ............................................................................................................................................... 34
3.9 Return Loss ....................................................................................................................................... 36
    3.9.1 Formula ..................................................................................................................................... 36
    3.9.2 Single Channel ....................................................................................................................... 36
    3.9.3 Multiple Channels .................................................................................................................. 36
4 Known Issues ......................................................................................................................................... 37
5 Revision history ...................................................................................................................................... 37

Figure

Figure 1: Select COM port .................................................................................................................... 7
Figure 2: Explorer User Interface Main Window ................................................................................ 8
Figure 3: The status bar ....................................................................................................................... 9
Figure 4: Reader Control bar ............................................................................................................. 9
Figure 5: Inventory Rule ..................................................................................................................... 10
Figure 6: Tag Access dialog box, Access Type Read selected ............................................................. 10
Figure 7: Tag Access dialog box, Access Type Write selected ............................................................ 11
Figure 8: Tag Access dialog box, Access Type Kill selected .............................................................. 12
Figure 9: Tag Access dialog box, Access Type Lock selected .......................................................... 12
Figure 10: Tag Access dialog box, Access Type BlockWrite selected ............................................. 13
Figure 11: Tag Access dialog box, Access Type BlockErase selected .............................................. 14
Figure 12: View Menu Options – During Reader Command Execution ............................................ 15
Figure 13: View Menu Options - Build Post-Capture View ............................................................... 16
Figure 14: Automatically Perform Post-Capture Processing ............................................................. 16
Figure 15: View Menu Options - Post-capture Views ....................................................................... 17
Figure 16: Data Logging ...................................................................................................................... 19
Figure 17: Log File Example .............................................................................................................. 19
Figure 18: Accessing the Reader Configuration Dialog ................................................................. 21
Figure 19: Reader Configuration Dialog Box .................................................................................... 21
Figure 20: Antenna Configuration ..................................................................................................... 22
Figure 21: Antenna Logical Settings .................................................................................................. 23
Figure 22: Select Criteria View ........................................................................................................ 24
Figure 23: Select Criteria Edit Dialog ............................................................................................... 24
Figure 24: Algorithm Settings View Page ......................................................................................... 25
Figure 25: Inventory Algorithm Edit Page ........................................................................................ 25
Figure 26: Post Singulation Criteria View Page ............................................................................... 26
Tables

Table 1: Live Data Views .......................................................... 15
Table 2: Post-Capture Packet Views ........................................ 17
Table 3: Post-Capture Diagnostic Views .................................... 18
Table 4: Post-Capture Performance View ................................. 18
Table 5: Log File Field Definitions .......................................... 20
Table 6: Revision history ....................................................... 37
1 Introduction

1.1 Overview

Explorer application is a .NET-based graphical user interface (GUI) tool. It can exercise the functionality of the reader platform, a platform that is based on the MTI R1000 chip, and firmware respectively. Explorer also support test functions to confirm the performance.
2 Explorer Installation

2.1 Installation Requirements

Explorer relies on release 2.0 of the Microsoft .Net Framework. The Explorer setup program checks to ensure that the correct version of the .Net Framework is installed. If the correct version is not installed, the Explorer setup program offers to install it. The user may also download and install a copy of the .Net Framework from the Microsoft Windows Update Site (http://update.microsoft.com/) or the Microsoft Download Center (http://www.microsoft.com/downloads/).

To take advantage of the data import/export feature, Microsoft Excel 2003 is required.

2.2 Installation

It is possible for multiple versions of Explorer to co-exist on a single system, so long as a unique install path is used for each, such as the default installation directory.

2.2.1 Installation Procedure

To install the Explorer tool:

1. Double click the Explorer installer file, MTI RFID Explorer [Version].msi, to launch the installation wizard.
2. When prompted, designate the desired installation directory. The default is [Program Files]\MTI\MTI RFID Explorer [version]\.
3. Installation includes the C++ runtime libraries and adds a desktop shortcut to the Explorer application.
4. To Start the Explorer application:
   ○ Double click the desktop shortcut, or Use the Start Menu. For example, if installed to the default directory:
     Click Start, Select All Programs, MTI, MTI RFID Explorer [version], Click Explorer.
   ○ Open the Explorer installation folder and double click Explorer.exe.

2.2.2 Removal Procedure

To uninstall the Explorer tool:

1. Click Start, Select All Programs, MTI, MTI RFID Explorer [version], Click Uninstall Explorer.
2. When prompted to uninstall this product, click Yes.

Alternatively:

1. Open the Control Panel and select Add or Remove Programs.
2. Select the entry for the Explorer version to uninstall and click Change/Remove.
3. When prompted to remove this product, click Yes.
2.2.3 Configuring for Serial Operation

1. Open Explorer and select “Tools”, ”Set COM port” option in the tool bar.
2. Type COM port number.
3. Click Set.
4. Select Yes or No.

This window contains the COM port number. Explorer will use this number to connect the device. If this setting is changed, Explorer will close. With Serial operation, only a single reader can be controlled.

![Figure 1: Select COM port](image)
3 Explorer Usage

This section describes the features of the Explorer Application.

Explorer has been adapted with reader platform differences in mind. Consequently, Explorer supports the RU-861-based reader, hereafter referred to as the reader.

3.1 Explorer Appearance

The Explorer consists of a main display window See figure below.

- The main window contains a menu and a main display area used to show different views of the data received from the reader.
- The control bar is used to start, stop, and pause inventory rounds, and to perform other reader actions.

![Figure 2: Explorer User Interface Main Window.](image-url)
3.2 Detect a Device and Select a Mode

3.2.1 Detect a Device

When the Explorer application starts, it attempts to open one attached readers. Explorer detects USB Interface first. If no reader is found by USB, Explorer starts to detect the serial port.

If any reader is found, it shows Device Interface (USB or Serial) and serial number. Otherwise, it shows “No Device”.

3.3 Controlling a Device

After detecting the reader, you can control the reader from the Reader Control menu or from the Control Bar. The figure below shows the Control Bar buttons and describes the actions they perform.
3.3.1 Inventory Rules

The **Activate Select Rules** and **Active Post-Singulation Rules** checkboxes control whether the select and post singulation criteria that have been configured should be utilized during inventory operations.

![Inventory Rule Figure](image)

3.3.2 Tag Access

Selecting the **Tag Access** option presents the user with the configuration dialog shown in the figure below:

![Tag Access dialog box, Access Type Read selected](image)

From the **Tag Access** dialog box, the user can perform many different access operations against tags as follows.

The **Activate Select Rules** and **Active Post-Singulation Rules** checkboxes control whether the select and post singulation criteria that have been configured should be utilized during read, write, and similar operations.

3.3.2.1 Access Type Read

Selecting the **Read** Access Type option displays the configuration dialog shown in the figure above.

From this dialog, the user can perform a read operation against tags and can provide the following configurable parameters:
- **Memory Bank**—the target for the read operation, has selectable values of either the EPC, TID, User, or Reserved memory bank
- **Offset**—the offset in hexadecimal of the first 16-bit word to read from the target memory bank
- **Count**—the number of 16-bit words to read, starting at Offset
- **Access Pwd**—the previously applied access password for the target tag, or no entry for tags with no access permissions

Output from read operations is directed to the primary application window.

### 3.3.2.2 Access Type Write

Selecting the **Write** Access Type option displays the configuration dialog shown in the figure below.

![Tag Access dialog box, Access Type Write selected](image)

From this dialog, the user can perform a write operation against tags and can provide the following configurable parameters:

- **Memory Bank**—the target for the write operation, has selectable values of either the EPC, TID, User, or Reserved memory bank
- **Offset**—the offset in hexadecimal of the first 16-bit word to write from the target memory bank
- **Count**—the number of 16-bit words to read, starting at Offset
- **Value 1**—the hexadecimal value of the 16-bit word to write at Offset
- **Value 2**—the hexadecimal value of the 16-bit word to write at Offset+1, applicable if Count is 2
- **Access Pwd**—the previously applied access password for the target tag, or no entry for tags with no access permissions

Output from write operations is directed to the primary application window.
### 3.3.2.3 Access Type Kill

The kill operation allows the user to render any tag with a matching access and kill password as permanently non-functional. Selecting the **Kill** Access Type option displays the configuration dialog shown in the figure below.

![Figure 8: Tag Access dialog box, Access Type Kill selected](image)

**Note:** Tags with a value of zero for their password are not expected to respond to the kill command.

### 3.3.2.4 Access Type Lock

The lock operation allows the user to specify the desired exposure of tag kill and access password permissions. It also allows the user to specify write permission and condition levels for the EPC, TID, and User memory banks. Selecting the **Lock** Access Type option displays the dialog box shown in the figure below.

![Figure 9: Tag Access dialog box, Access Type Lock selected](image)
Note that all permissions are set in a single operation. In many circumstances, it may be desirable to leave one or more of the target passwords or permissions in an unmodified state. To do this, select the NO_CHANGE option for those targets.

### 3.3.2.5 Access Type BlockWrite

Selecting the **BlockWrite** Access Type option displays the configuration dialog shown in the figure below.

![Tag Access dialog box, Access Type BlockWrite selected](image)

From this dialog, the user can perform a block write operation against tags and can provide the following configurable parameters:

- **Memory Bank**—the target for the read operation, has selectable values of either the EPC, TID, User, or Reserved memory bank
- **Offset**—the offset in hexadecimal of the first 16-bit word to read from the target memory bank
- **Count**—the number of 16-bit words to read, starting at Offset
- **Value 1**—the hexadecimal value of the 16-bit word to write at Offset
- **Value 2**—the hexadecimal value of the 16-bit word to write at Offset + 1, applicable if Count is 2.
- **Access Pwd**—the previously applied access password for the target tag, or no entry for tags with no access permissions

Output from block write operations is directed to the primary application window.
3.3.2.6 Access Type BlockErase

Selecting the BlockErase Access Type option displays the configuration dialog shown in the figure below.

![Tag Access dialog box, Access Type BlockErase selected](image)

From this dialog, the user can perform a read operation against tags and can provide the following configurable parameters:

- **Memory Bank**—the target for the read operation, has selectable values of either the EPC, TID, User, or Reserved memory bank
- **Offset**—the offset in hexadecimal of the first 16-bit word to erase in the target memory bank
- **Count**—the number of 16-bit words to erase, starting at Offset
- **Access Pwd**—the previously applied access password for the target tag, or no entry for tags with no access permissions

Output from block erase operations is directed to the primary application window.
3.4 RFID Data Views

3.4.1 Overview

The Explorer provides several views that allow users to examine RFID data from different perspectives. Use the View menu (on the main window) to select different views.

Explorer provides two types of data views:

- Live data views, which are captured in real-time from the reader
- Post-capture views, which are generated after an operation is completed

The live data views display data as the packets arrive from the reader. The application applies minimal processing to this live data. The following table describes the three live data views that are available.

<table>
<thead>
<tr>
<th>View Name</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary View</td>
<td>Overview statistics about the current session, currently executing command and reporting time slice.</td>
</tr>
<tr>
<td>Standard View</td>
<td>A list of unique tag singulations (tag id inventoried) in the session and a count of the number of times the id was read (inventoried).</td>
</tr>
<tr>
<td>Protocol Trace</td>
<td>A graphical view of the packet data for the current (active) command broken out by the packet fields. The packets are logic packets. Not physical packets.</td>
</tr>
</tbody>
</table>

Note that while a reader is actively executing a command, such as Inventory, only live data views are available. Even if a user has selected a post-capture view, the view is automatically switched to a live data view when a command is issued to the reader.

While the command is running, users can switch between any of the three live views (Summary, Standard and Protocol Trace). However, the user interface prevents users from switching to any of the post-capture views. See the figure below.

![Figure 12: View Menu Options – During Reader Command Execution](image)
3.4.2 Performing Post-Capture Processing

After reader functions has completed, Explorer must perform the post-capture processing to create the post-capture views. The post-capture processing builds an index of the captured data which provides the data for the post-capture views.

You can perform the post processing by initiating it yourself or by configuring the application to invoke it automatically. The procedure for each approach is described below:

- To initiate the post processing (i.e., to build the indexed data file), select **Build Post-Capture Views** as shown in the figure below. This option is enabled after the reader functions have completed.

- To configure the application to automatically invoke the post-capture processing:
  1. From the **Tools** menu, select **Explorer Options**. The Explorer Option dialog box displays.
  2. Select **Automatically perform post-capture processing** as shown in the figure below.
When the post-capture processing completes, all views become available from the View menu, as shown in the figure below.

![View Menu Options - Post-capture Views](image)

Except for the Reader Protocol view, all post-capture views are divided into three groups under the submenus:

- Summary Views
- Diagnostic Views
- Performance Views

The Protocol Trace is the only view that supports the display of both live and post-capture data. When the reader is active, the Reader Protocol view displays the last one thousand captured packets for the current command. When the post-capture process completes, the Reader Protocol view displays all packets for the active session.

The following table lists the post-capture packet views that are available:

<table>
<thead>
<tr>
<th>View Name</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag Access</td>
<td>Lists in chronological order all Inventory Response packets received from the reader. The view includes the Tag ID, time of packet arrival, the Antenna number, device time, the access type, and the tag data.</td>
</tr>
<tr>
<td>Command Summary</td>
<td>Provides summary information about the commands executed by the reader in the current session. Data items include elapsed time of the command, execution mode, tag count, unique tag count, and tag read rate.</td>
</tr>
<tr>
<td>Antenna Cycle Summary</td>
<td>Provides summary information about the antenna cycles executed by the reader in the current session. Data items include the number of antennas included, the tag count, unique tags, and tag singulation rate.</td>
</tr>
<tr>
<td>Inventory Cycle Summary</td>
<td>Provides a summary of all of the inventory cycles included in the current session (or since the last time the session was cleared). The view includes the total and unique tag count, logical antenna number, and read rate.</td>
</tr>
</tbody>
</table>
Inventory Round Summary | Lists data related to each inventory round including the antenna used, tag count, and elapsed time in milliseconds.
---|---
Inventory Parameters | Lists the parameter used in the session’s inventory rounds.

The following table lists the post-capture diagnostic views that are available:

<table>
<thead>
<tr>
<th>View Name</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Packets (Raw Format)</td>
<td>Lists in chronological order all packets received from the reader.</td>
</tr>
<tr>
<td>All Packets (Raw Format)</td>
<td>Lists invalid or unrecognized packets, the raw data, and the parsing error.</td>
</tr>
<tr>
<td>Inventory Cycle Diagnostics</td>
<td>Lists diagnostic information for each inventory cycle.</td>
</tr>
<tr>
<td>Inventory Round Diagnostics</td>
<td>Lists the diagnostic information for each inventory round.</td>
</tr>
</tbody>
</table>

**Note:** The extended data format must be selected to obtain this information.

The following table lists the post-capture performance view that is available:

<table>
<thead>
<tr>
<th>View Name</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Singulation Rate Data</td>
<td>Provides data useful for calculating the read rate achieved by the reader.</td>
</tr>
</tbody>
</table>

### 3.5 Exporting Data

The Explorer application allows you to export data to Microsoft Excel 2003. To export data:

- From the **File** menu, click **Export**. A dialog box opens from which you can select the views you wish to export. You can export one or more views at a time.

The application saves exported files in the user’s directory. After the export completes, Explorer invokes Microsoft Excel, or the associated application for xml format worksheets, to open the exported data file. Each view selected for export becomes a separate sheet in an Excel workbook.

**Note:** Microsoft Excel allows only the first 65536 rows in each view to be exported. If a session is too big for Excel, you can always view it in the Explorer application.
3.6 Logging Data

Explorer supports the logging to a text file of all packets received from readers. See figure below To enable logging:

1. From the Tools menu, click Explorer Options. This opens the Explorer Options dialog box.
2. In the Explorer Options dialog box, click the Data Logging tab.
3. Select the Enable Logging check box.
4. If desired, specify an alternative directory in which log files should be stored.

The log files created by Explorer are named rfidxxxx.log, where xxxx is a four digit sequence number. The figure below shows an example of log file content.
The log file contains four fields separated by tab characters. These fields are defined in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Radio Index</td>
<td>A unique serial number for the reader.</td>
</tr>
<tr>
<td>Time stamp</td>
<td>Elapsed time in milliseconds from the start of the session.</td>
</tr>
<tr>
<td>Symbolic Name</td>
<td>The symbolic name for the packet.</td>
</tr>
<tr>
<td>Packet Data</td>
<td>The packet data in hexadecimal format.</td>
</tr>
</tbody>
</table>
3.7 Accessing and Changing Reader Configuration

The Explorer application allows the user to configure many of the settings of the attached readers. To access the configuration panel:

- From the Reader Control menu, select Configure Reader. Alternatively, from the Tool Bar, select Configure Reader. See the figure below. This opens the Explorer Reader Configuration dialog box.

![Figure 18: Accessing the Reader Configuration Dialog](image)

The Explorer Reader Configuration dialog contains many function-specific pages, each of which is listed on the left-hand side selection bar. The current selection is always indicated by a visual highlight. For example, in the figure below, the Settings page is active.

![Figure 19: Reader Configuration Dialog Box](image)
3.7.1 Settings Page

When the Reader Configuration dialog first opens, it displays the Settings page shown in the figure above. The settings displayed are the current settings on the reader.

From this page, you can view and/or configure the following items:

- Communication Port
  Set the reader communication to USB or Serial. If clicks “Update”, Explorer will be closed. Need to restart the reader.
- Operating Region
- Link Profile (Read only)
- Inventory Algorithm (Fixed Q or Dynamic Q)

Note: RU-824 Reader doesn’t support UART function. If connect RU-824, Explorer will disable Update UART function.

3.7.2 Antenna Configuration Page

From the Antenna Configuration page, you can configure the reader’s 16 logical antenna ports. As the figure below shows, this page displays the current antenna configuration within a grid.

![Figure 20: Antenna Configuration](image)

The Import and Export buttons allow the antenna data to be manipulated by Microsoft Excel and then imported back into the reader.

To change the setting for a logical antenna, click its associated Edit button in the first column of the grid. This displays the dialog box shown in the figure below.
Configurable parameters for individual antennas are:

- **Physical Port** indicating the physical connector (0 thru 3) to which the logical antenna is bound for transmission of data.
- **Maximum Dwell Time** indicating the maximum number of milliseconds that may be spent on the logical antenna during a single cycle.
- **Maximum Inventory Cycles** specifying the maximum number of inventory cycles that will be spent on the logical antenna before a switch to the next one available.
- **Antenna transmission Power** in 1/10 dBm increments.

**Note:** The dwell time and inventory cycles may not both be set to a value of zero. If the user attempts to perform such an operation, Explorer will response error message.
3.7.3 Select Criteria Page

Use the Select Criteria page to view and configure the selection criteria query settings that can be used for any tag–protocol operations. As shown in the figure below, this page displays the active selection criteria of the current reader.

![Select Criteria View](image)

Figure 22: Select Criteria View

The Display Criterion # spin box allows you to select the criteria currently being viewed. It has a range of one (1) up to the value displayed under Active Criteria. The Load button causes the application to perform a direct query to the current reader and reload the page with the retrieved select criteria settings.

To change the select criteria parameters for the active reader, click the Edit button. This displays the dialog box shown in the figure below.

![Select Criteria Edit Dialog](image)

Figure 23: Select Criteria Edit Dialog

This panel allows configuration of individual select criterion parameters.
**Note**: Truncation is not supported in the MTI firmware at this time. The **Truncation** parameter should be set to **DISABLE**.

### 3.7.4 Inventory Algorithm Panel

The Inventory Algorithm panels are used to view and configure the reader’s query settings. The figure below shows an example of the Inventory Algorithm View panel.

![Algorithm Settings View Page](image)

Figure 24: Algorithm Settings View Page

The **Load** button queries the current reader and refreshes the values displayed on the **Algorithm Settings** page.

To modify the algorithm settings for the current reader, click the **Edit** button. This opens a dialog box similar to the one shown in the figure below.

![Inventory Algorithm Edit Page](image)

Figure 25: Inventory Algorithm Edit Page
In the **Active Algorithm** dropdown box, you can select between the Fixed Q and Dynamic Q algorithm. When you select a new algorithm, the configurable fields display in the center sub-panel change to match those available with the selected algorithm.

### 3.7.5 Post Singulation Criteria Page

Use the **Post Singulation** page to view and configure reader settings that define the manner in which tags and post singulation are filtered (based on all or part of the tag’s EPC).

The figure below shows an example of the page displayed when the **Post Singulation Criteria** option is chosen.

![Post Singulation Criteria View Page](image)

The **Display Criterion #** spin box allows you to select the criteria currently being viewed. It has a range of one (1) up to the value displayed under **Active Criteria**.

The **Load** button causes the application to perform a direct query to the current reader and reload the page with the retrieved post singulation criteria settings.

To change the post singulation criteria parameters for the active reader, click the **Edit** button. This displays the dialog box shown in the figure below.
This page allows configuration of individual post singulation criterion parameters.

**Note:** Only one active post singulation criteria is allowed at this time. Attempts to set the **Active Criteria** count greater than one (1) in the **Edit** dialog result in an Invalid Parameter error. This error is generated and displayed when the **Save** button is clicked.
3.7.6 GPIO Pin Configuration Page

Use the GPIO Pin Configuration page to set and retrieve the current values of General Purpose Input/Output (GPIO) pins which are accessible to the user on the MTI Firmware microcontroller. The figure below shows the GPIO panel.

![GPIO Pin Configuration Panel](image)

To retrieve the current value for a specific GPIO pin:

1. Set the **Access** value to **GET**.
2. Click the associated **Apply** button. The **State** column then indicates the retrieved value—**LOW** for a binary value of zero or **HI** for a binary value of one. If the operation fails, the **Status** field indicates this and the displayed state changes to **Unsupported**.

To retrieve the current values of all GPIO pins:

- Click the **Read All** button. This operation sets all pins to **GET** mode and retrieves the current values from the system.

To set a value for a specific GPIO pin:

1. Change the **Access** value to **SET**.
2. Change the **State** field to the desired value.
3. Click the associated **Apply** button.
3.7.7 About Reader Page

The About Reader page is a static page that provides versioning information for the MTI components of the reader. It provides a single place to find the version information for the MTI device, MTI Firmware, and MTI BootLoader. The figure below shows a sample About Page.

![About Reader Page](image)

Figure 29: About Reader Page

3.7.8 Troubleshooting Panel

The Troubleshooting page provides access to the MTI Firmware error register as well as the ability to clear the error and reset the MTI Firmware. See the figure below.

![Troubleshooting Page](image)

Figure 30: Troubleshooting Page

Note: Performing a Reset Firmware operation causes a reset of the connection to the current reader. The reader will no longer be accessible via the application until the application is restarted.
3.7.9 Register Access Panel

It is recommended that you have a very strong understanding of the behavior of the underlying MTI Firmware prior to modifying register values directly via this method.

For the purpose of controlling and configuring the reader, the Explorer application allows the user to read and write the various MTI Firmware registers.

3.7.9.1 Register Type Mac

Selecting the Mac Register Access option displays the dialog shown in the figure below. From this dialog, the user can perform read and write access to MAC Registers.

![Register Access Dialog](image)

Figure 31: MAC Registers Page

To read an individual MAC register value:
- Enter the hexadecimal start address and the total number registers to read.
- Click the Read button. If a register cannot be read, for example because of an invalid address entry or the register is write-only, a read fail result will be displayed in the status window.

To write an individual MAC register value:
- Enter the hexadecimal start address and the hexadecimal value to write.
- Click the Write button. If a register cannot be written, for example because of an invalid address entry or the register is read-only, a write fail result will be displayed in the status window.

- The Batch button allows for batch processing of multiple registers. Select the ? button for Register Access Batch Help and file format.
- The Dump MAC button reads all MAC registers and dumps the data in the status window.
- The Clear Status button clears the status window.
- The Save Status button allows the content of the status window to be saved to a file.
- Check Keep History to retain all access history in the status window. Uncheck Keep History to retain only the last access record in the status window.
3.7.9.2 Register Type MacBank

Selecting the MacBank Register Access option displays the dialog shown in the figure below. This dialog reduces the user input required to perform read and write access to MAC Banked Registers.

![Figure 32: MAC Banked Registers Page](image)

The configurable parameters for MAC Banked Register read operations are identical to Mac Register read. The figure below shows the status window for a valid banked register read, detailing the currently selected bank, the applicable selector address, and the content of all banks.

![Figure 33: MAC Banked Register Read Status Example](image)
The configurable parameters for MAC Banked Register write operations are identical to MAC Register write, except that an additional bank parameter is provided. This alleviates the need to utilize the Mac Register Access dialog to select the desired bank via the bank selector register before performing banked register operations. The figure below shows the status window for a valid banked register read, detailing the currently selected bank, the applicable selector address, and the content of all banks. This is followed by a write to each bank by simply changing the bank index.

![Figure 34: MAC Banked Register Read and Write Status Example](image)

### 3.7.9.3 Register Type Bypass

Selecting the **MacBypass** Register Access option displays the dialog shown in the figure below. From this dialog, the user can perform read and write access to Registers.

![Figure 35: MAC Bypass Registers Page](image)

The configurable parameters for Bypass Register read and operations are identical to Mac Register read.
3.7.9.4 Register Type OEM

Selecting the **OEM** Register Access option displays the dialog shown in the figure below. From this dialog, the user can perform read and write access to the OEM Registers.

![OEM Registers Page](image)

Figure 36: OEM Registers Page

The configurable parameters for OEM Register read and operations are identical to those in section Mac Register write.
3.8 RF Test

MTI supports 3 functions which are “Inventory”, ”RF On/Off” and ”Pulse” to help user to perform the device. Select Configure option. Click RF Test. The RF Test dialog will be show.

In the “Hopping” Channel, only support “Inventory”. In the “Single” Channel, support full function to perform the device.

Start one test flow at one time. Another buttons become disable status until stop the test flow. In the test time, Explorer doesn’t allow user to exit the dialog.

Click RF On/Off button, start to CW On/Off flow. Click Pulse button, start to transmit random data. Click Inventory button, start to inventory and you can watch the tag information in the main views.
Figure 39: RF Test – Tag information is showed in the main views

If you want Explorer to run continually after received error, click the box “Keep inventory after received error”. In normal mode, after receive error message in the End Packet, Inventory will stop. In this test mode, Inventory stop soon, then run again automatically.

Figure 40: RF Test – Keep inventory after received error
3.9 Return Loss

MTI supports “Return Loss” to help user to perform the device. Select **Configure** option. Click **Return Loss**. The Return Loss dialog will be show.

![Figure 41: Return Loss – Select Return Loss](image)

### 3.9.1 Formula

Return Loss = **Reflected Power Level** (0xB04) – **PA Power Level** (0xB00).

### 3.9.2 Single Channel

Explorer has Frequency tables which is support-region. Choose one single in Frequency Box, and click “Run” Button. Explorer will show the channel information in the window.

**Note:** If your region is “Customer”, you should type the frequency by yourself. Explorer doesn’t know the frequency that you want.

### 3.9.3 Multiple Channels

Click **CHANNEL_ALL** in the frequency Box. Click **Run** button. Explorer will show all channels and paint Broken Line Graph.

**Note:** “Customer” region doesn’t support this function.

![Figure 42: Return Loss - Multiple channels Broken Line Graph](image)
4 Known Issues

- The application does detect new readers that become active after the application has started. You should power on and connect your readers prior to starting the Explorer application.
- The names of detected readers are displayed as ASCII. Truncation is not supported in the Firmware Release v2.4.2, so selecting it in the Select criteria will render an error.

5 Revision history

<table>
<thead>
<tr>
<th>Version Number</th>
<th>Description</th>
<th>Revision Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0.0</td>
<td>First release of document. \nThe revision is used on software version 1.0.4</td>
<td>Oct 6, 2011</td>
</tr>
</tbody>
</table>